
Adobe Photoshop CC 2015.1 
December update

Welcome to the latest Adobe Photoshop CC bulletin 
update. This is provided as a free supplement to the Adobe 
Photoshop for Photographers book to ensure readers are 
kept up-to-date with the latest changes in Photoshop.

This Photoshop CC 2015.1 update includes information 
about the main things that are new to Photoshop CC. The 
features described here will be accessible to all Creative 
Cloud subscribers using Photoshop CC. For a complete 
description of how to use these new Photoshop tools, with 
diagrams and step-by-step tools, I recommend you buy 
the Adobe Photoshop CC 2015 for Photographers book by 
Martin Evening.
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Photoshop CC 2015.1

New user interface
Photoshop has a brand new interface, which has been 
introduced for a number of reasons. It at last provides unified 
themes across all the interface components including items 
such as filter dialogs, plug-ins and Script interface dialogs. As 
before, there are four color theme brightness levels to choose 
from. Therefore, if you prefer working with a dark color theme, 
all the dialogs in Photoshop will have a consistent appearance. 
The interface has a more modern look with rounded rectangle 
buttons and a discrete blue accent on selected fields (see 
Figure 1). The aim of this redesign has been to minimize 
the interface components that serve minimal purpose, 
while giving more emphasis to the elements that are most 

Figure 1 Examples of the new Photoshop CC interface.
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Figure 2 The Swatches panel with the Large 
Tabs option enabled in the preferences. 

important. For example, the field boxes where you modify the 
values have a stronger emphasis than the field label names. 
This helps direct the eye to where the user’s attention needs 
to be focussed most.
	 Consideration has also been given to users working with 
touch-enabled devices, where the Large Tabs option in the 
Photoshop Workspace preferences will make them easier 
to select. Likewise, the swatch sizes in the Swatches panel 
(Figure 2) have been made larger. You will find that the Small-
size swatches are now roughly the same size as the Large-size 
swatches were in previous versions of Photoshop.

New Start Screen/Recent files experience
When you first launch Photoshop you will see the Start screen 
workspace shown in Figure 3, where you have the option to 
select a recently opened file, access Library assets, or select 
a new document preset (see Figure 4). However, this is only 
seen if you are using Photoshop in Application Frame mode. To 
switch to this, go to the Window menu and select ‘Application 
Frame’. Otherwise, all you will see when you launch Photoshop 
is your regular default workspace. Personally, I find the new 
Start workspace experience rather unsettling because it 
makes you wonder, when you first launch Photoshop each 
time, “where have all the Photoshop panels gone?” However, 
as soon as you open an image, via the startup screen, or 
via Bridge, the interface switches to the regular workspace 

Figure 3 The new Start screen workspace in Application Frame mode.

Generic icons
The most recently used files can be made 
to appear as a list with generic icons (as 
shown in Figure 3. This is probably a 
good thing for professional photographers 
who need to respect client confidentiality 
agreements.
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configuration and the startup screen disappears. When you 
close all open files the start screen workspace reappears again. 
If the Start screen bugs you there is an option to disable this. Go 
to the Photoshop General preferences and deselect ‘Show Start 
Workspace When No Documents Are Open’ (see Figure 5).

Figure 5 The General preferences.

Figure 4 The Start screen workspace showing the new document presets.
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Figure 7 The New Library from Document dialogs. The one on the left appears 
automatically when opening files that contain relevant content. The one on the right 
opens when you click on the Library from Content button in the Libraries panel 
(Figure 6).

Figure 6 The Libraries panel.

Auto vacuum feature
As you open new files in Photoshop, you will sometimes see 
the New Library from Document dialog shown in Figure 7. This 
can be used to automatically batch pull the contents from a 
new document into a new Library. This dialog only pops up on 
screen whenever you open a document that contains relevant 
content, such as character styles, colors and layer styles. 
There is a Don’t Show Again option at the bottom, but you can 
choose to bring it back again by going to the Libraries panel 
fly-out menu. Or, you can click on the Library from Document 
button (circled in Figure 6) to open the dialog shown on the 
right in Figure 7.
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Figure 8 The Customize Toolbar interface.

Toolbar presets
You can now edit the Toolbar in Photoshop. To do this, go to 
the Edit menu and choose Toolbar… This opens the Customize 
Toolbar dialog shown in Figure 8, where you will see a list 
on the left of all the current Photoshop tools organized by 
their regular groupings. These are referred to as ‘slots’. The 
Customize Toolbar dialog allows you to drag and drop tools 
out from the Toolbar section on the left to the Extra Tools 
section on the right. You can also drag and drop to reorganize 
the grouping of the tools within a customized Toolbar layout. 

About 10-bit video and Photoshop
Macintosh users may have noticed that 10-bit video has been 
enabled in Mac OS X 10.11 (El Capitain) for the latest iMacs 
and Mac Pro computers. However, so far it seems this is only 
supported by certain programs, such as Apple Photos. There 
is no indication yet if Photoshop will be able to support 10-bit 
video.
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Figure 9 A customized Photoshop Toolbar (left) and overflow Toolbar items (right).

Figure 9 shows a customized reconfiguration of the Toolbar 
in which I removed the tools I felt were surplus to normal 
requirements for image retouching. For example, when editing 
photographs there is no use for the Slice and Slice select tools 
(which share the c shortcut as the Crop and Perspective crop 
tools). By moving both to the Extras section one can use the 
Sc key to toggle between the Crop and Perspective crop 
tools, rather than have to press the Sc key four times to 
cycle through all four tool options that share the same shortcut. 
If you click on the left-most 15 pixels you can retain all the tools 
in a group when moving (see Figure 10). 
	 At the bottom of the Customize Toolbar dialog (Figure 8) are 
options to show/hide the non-tool widgets that appear at the 
bottom of the Toolbar such as the Quickmask mode options 
and Cycle screen mode options (these are shown disabled in 
Figure 9).

Figure 10 Click on the left-most 15 pixels 
of a list to retain tools in a group when 
moving.

Toolbar shortcuts
Removing an item from the Toolbar also 
disables the shortcut. This can have 
unintended consequences if you remove 
things like the Screen view or Quickmask 
options in order to remove clutter from the 
Toolbar, you lose the shortcut as well.
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	 Just below the Zoom tool is the Edit Toolbar widget, 
which if you click on it, displays the overflow Toolbar items as 
a flattened list (see Toolbar on the right in Figure 9) and also 
provides a shortcut to open the Customize Toolbar dialog.
	 Once you are happy with a configuration you can click on 
the Save Preset button to save a custom Toolbar configuration 
and also load presets via the same dialog. Alternatively, if 
someone sends you a Toolbar preset you can load it by dragging 
and dropping to the Photoshop application icon.

Export options update
The Export Options dialog (Figure 11) can be accessed by 
going to the File menu and choosing Export ➯ Export As… 
This essentially provides an alternative way to export images 
or layer selections (via the Layers panel) in a way that is 
potentially faster and with fewer steps than using Save for Web 
(such as when using the Quick Export option). 

Figure 11 The new Export Options dialog.
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User interface refinements
The interface has been updated to include the ability to resize 
the dialog. The height and width controls of the Export As 
dialog now support navigation via arrow controls and scrubby 
sliders. The width, height and Scale dialogs are all linked so 
that when a custom value is entered to one setting the other 
two update automatically. The last used file format and other 
export settings are remembered when choosing File ➯ Export 
➯ Export As…

PNG format user interface
Instead of having ‘PNG’ and ‘PNG-8’ file format options in the 
File Settings section, there is now just a single ‘PNG’ format 
option where you can select ‘Smaller Size (8-bit)’ to output 
using the PNG-8 format.

Color space option
Thee is a Metadata section where you can choose to export 
with None, or with Copyright and Contact information. In the 
Color Space section there is an option to ‘Convert to sRGB’. 
Unfortunately this also strips the profile from the file when you 
export and, unlike the Save for Web method, there is no option 
to include or exclude a profile on export.
	 For exports that are destined to appear in a website there is 
a good reason to not include a profile since all Web browsers 
will assume sRGB in the absence one. This allows Web 
designers to economize on the file size by omitting the profile 
data from the file. But for nearly everything else it is essential a 
profile is included. This does therefore limit the Export Options 
to Web export use only. Files exported from the new Export 
Options will appear non-color managed if they are used for 
anything but a Web page layout. My recommendation is to use 
the Export Options with caution, or stick with Save for Web.

Touch interactions on Windows
Windows OS computers that feature touch screens such as 
the Microsoft Surface™ 3 and Surface™ Pro 3 computers 
are supported by Photoshop. In this latest release touch 
interaction on the canvas has been enhanced. Along with the 
existing two-finger gestures for manipulating the canvas view 
transformation, gestures have been added for moving back 
and forth through the document history states and for cycling 
between the three screen modes. The existing gestures plus 
the new ones are all listed in Figure 12.
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Existing gestures

Two-Finger Pan The canvas view may be panned by moving two fingers in any 
direction on the canvas without changing the distance between 
them or the angle of the line connecting them.  

Two-Finger Pan and 
Zoom

The canvas view may be panned and zoomed by moving two 
fingers toward or away from each other.

Two-Finger Pan and 
Rotate

The canvas may be panned and rotated by rotating two fingers 
around the center of the line connecting them.

Two-Finger Free 
Transform

To apply a free transform, rotate two fingers around the center 
of the line connecting them while simultaneously moving them 
nearer to or further from each other.

Following on from the above, place two fingers on the tablet 
surface and keep them motionless for a moment. The canvas view 
may then be freely panned, zoomed or rotated.

Two-Finger Reset or 
Restore View

Double-tap two fingers on the tablet surface to reset view to an 
unrotated transform that nearly fills the document canvas. Double-
tap with two fingers again to restore the view to its previous state.

New gestures

Two-Finger Step Back in 
History (Undo)

To go back one step in the history, move two fingers rapidly from 
right to left.

Two-Finger Step Forward 
in History (Redo)

To go forward one step in the history, move two fingers rapidly 
from left to right.

Three-Finger History 
Scrub

To move in a continuous fashion through the entire history,
move three fingers right or left on the tablet surface. 

Five-Finger Cycle Screen 
Mode

Tap once with five fingers to cycle through the three application 
display screen modes (including the full screen mode). 

Figure 12 A summary of gestures available when working with a Windows touch screen-enabled  computer.
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Updated Libraries panel 
The Libraries panel (Figure 13) has also been updated to 
the new interface look. The Stock Photos button has been 
removed from the bottom of the panel and you will now find 
the Libraries panel has an integrated search box just below 
the library pop-up menu (circled in Figure 13). You can use the 
pop-up menu on the right to pick what it is you want to search. 
The default option is ‘Adobe Stock’, but you can change this 
to search the Current Library, or All Libraries. You will find this 
new addition is available in all Adobe Creative Cloud desktop 
applications that support Libraries.

Adding assets to the Libraries panel
As well as being able to drag layer assets between the 
Libraries panel and Layers panel, you can now also add Brush 
Presets by dragging them across. With Color Swatches and 
Layer Styles you used to have to select a swatch as the 
foreground color and click the color swatch button at the 
bottom to add it to a library. Now, all you have to do is just 
drag and drop to the Libraries panel. Similarly, you can drag 
and drop a Layer Style to add it to the Libraries panel.

Figure 13 The new Libraries panel.

Linked assets
Assets in Creative Cloud Libraries can 
now be linked so that when a change is 
made to a graphic or layer, it can update 
any document that uses that asset. You can 
therefore update assets across Photoshop, 
Illustrator or InDesign projects, wherever 
those assets are being used.
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Figure 14 This shows the before version (left) and after version (right) using the Oil Paint filter.

The return of the Oil Paint filter
The Oil Paint filter was first introduced in Photoshop CS6, 
but got removed when Photoshop was updated to 64-bit. 
However, the Oil Paint filter has now been brought back in 
Photoshop CC 2015.1. The main difference is it is now supplied 
as a built-in plug-in located in the Filter ➯ Stylize submenu (as 
opposed to a modal filter dialog). Otherwise, the Oil Paint filter 
controls are more or less the same as they were before.
	 If you are having trouble accessing the Oil Paint filter it may 
be because you have a graphics card/system configuration 
that does not support OpenCL v1.1 or higher (most modern 
graphics cards should). Or, it may be because the image you 
are editing is not in RGB color mode.
	 Figure 14 shows the Oil Paint filter in action, where I applied 
it to a copied layer of a beauty head shot using the settings 
shown here. I added a layer mask to the filtered layer (filled 
with black) and then painted with white on the hair areas only 
to reveal. Basically, I was able to use the Oil Paint filter to 
create smoother-looking hair.
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Glyph Panel update
The Glyph panel (Figure 15) now features a ‘most recently 
used’ bar at the top of the panel. This can hold up to 25 
different characters and is updated each time you select a 
new glyph from the panel with new glyphs being added from 
the left, displacing older, used glyphs as the limit is reached. 
The glyphs stored in this bar retain the associated font, so if 
you happen to select a new font in the Glyphs panel the ‘most 
recently used’ bar does not update the previously recorded 
glyphs based on the newly-selected font. You will also find that 
extra glyph characters are now accessible via this panel. 

Diffusion slider for healing tools 
The Healing Brush and Patch Tool (Normal mode) Toolbar 
options now include a Diffusion slider. This can be used to 
control how the pasted region adapts to the surrounding 
image. You will find that a lower Diffusion setting of say, 2 is 
ideal for images that contain a lot of noise or detailed texture. 
Higher values are best-suited for areas that contain smooth 
texture. You will also find that when the healing work is carried 
out on a separate new layer with All Layers, or Current Layer 
and Below selected, the healing blending results are improved 
when retouching close to the edges of a picture.

More compact 16-bit and 32-bit files
It is now possible to make 16-bit and 32-bit files more compact 
when saving them using the PSD format and with maximum 
compatibility turned off. How much you can save is dependent 
on the file content and how many layers there are in an image, 
but the savings can be quite dramatic. 
	 There are downsides of course. Disabling maximum 
compatibility means such files won’t be read by older versions 
of Photoshop that predate Photoshop CS6. Enabling maximum 
compatibility is also essential to maintain compatibility with 
Lightroom, or other third-party software that is normally able to 
read the PSD format.

Figure 15 The Glyphs panel.
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Adobe Photoshop CC 2015 for Photographers is written by Martin Evening and 
published by Focal Press. Available from Focal Press, Amazon.com and  
Amazon.co.uk.


